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1. Kernel for Novell GroupWise to Lotus Notes

Welcome to the user manual of Kernel for Novell GroupWise to Lotus Notes, the most effective 
convenient Novell GroupWise to Lotus Notes conversion software available online for migrating data from 
Novell GroupWise mailboxes to Lotus Notes. This software provides a secure migration to MS Exchange 
Server so that users can migrate Single GroupWise Mailbox or Unlimited GroupWise Mailboxes at once. 
This user manual consists of step by step guidelines on using this software to perform flawless migration.  

1.1  Using this Manual 

The user manual of Kernel for Novell GroupWise to Lotus Notes is devised to help the users perform 
accurate Novell GroupWise to Lotus Notes migration. It is suggested that the novice users should go 
through this user manual carefully before proceeding to use the software. If you are an experienced 
user, use the TOC to find out information related to tasks that you wish to perform using Kernel for 
Novell GroupWise to Lotus Notes. You can use the table of contents to navigate through various 
sections of this user manual. The table of contents comprises of all the sections in the user manual in 
chronological order. The user manual comprises the following sections: 

Introduction 

Getting Started 

Software Interface 

Migrating from Novell GroupWise to Lotus Notes 

Advance Options to Ease Migration 

Full Version 

Support 

Troubleshooting 

Legal Notice 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents 
of this user manual, please go through the list of abbreviations, mentioned below, before reading the 
manual.  

1.1.1 List of Abbreviations 

XLS: Excel Sheet Extension 

RAM: Random Access Memory 
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MB: Mega-Byte 

GB: Giga-Byte 

1.2  Introducing Kernel for Novell GroupWise to Lotus Notes 

Kernel for Novell GroupWise to Lotus Notes is reliable and powerful software devised especially to 
perform seamless and precise migration of data in Novell GroupWise mailboxes to NSF file format. 
Converting the data to NSF file format eases the user to access GroupWise email data with Lotus Notes 
email client. This is an eminent tool that performs accurate migration and allows you to convert all the 
data in your GroupWise mailbox to NSF file format. After GroupWise to Lotus Notes conversion, the NSF 
file is ready to be accessed with Lotus Notes.  

Novell GroupWise to Lotus Notes migration tool allows you to perform flawless migration in matter of 
three simple steps: Select, Export and Save. The software creates a new Notes Storage File (NSF) with 
the same folder structure of Novell GroupWise mailbox. Using this tool, you can migrate email 
messages, calendar entries, tasks, contacts etc for a pre-defined or specified time period at a desired 
location. 

1.3 Salient Features 

Salient features of Kernel for Novell GroupWise to Lotus Notes include: 

Convert single GroupWise Mailbox to Lotus Notes Mailbox 

Convert Unlimited GroupWise Mailboxes to Lotus Notes 

Supports UNICODE characters for conversion 

Facilitates migrating either all or selected mailbox folders to Lotus Notes 

Displays preview of GroupWise mailbox items before converting them into Lotus Notes mailbox 

Supports exporting archived GroupWise mailbox to Lotus Notes 

Exports emails, contacts, tasks, calendar, and other GroupWise mailbox items to Lotus Notes 

Enables users to migrate Address Book 

Lets you save data in text format  

Self-descriptive graphical user interface 

Supports every version 

Available with free evaluation version 
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2. Getting Started

Now that you have understood the features and potential of Kernel for Novell GroupWise to Lotus Notes, 
you are ready to experience the working of the software. In order to migrate from Novell GroupWise 
environment to Lotus Note environment, you need to download and install this software. However, it is 
strongly recommended that before you install Kernel for Novell GroupWise to Lotus Notes, you must 
check the installation pre-requisites for the software to ensure that your computer is apt for running the 
software.  

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Novell GroupWise to Lotus Notes can be 
broadly classified into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

Pentium class processor 

512 MB RAM  

13 MB for Software installation 

Disk Space - Enough space to save the results 

 You should have at-least 13 MB of free disk space if you want to convert and save
13 MB email data. 

2.1.2 Software Requirements: 

The software requirements for installing the software are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

Windows 7 

Windows Vista 

Windows XP 

Windows 2003 

Windows 2000 
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2.1.2.2 Email Client Requirements 

Supported Novell GroupWise Server Versions- Supports all versions of Novell GroupWise including 
4.1 to 8.0 

Supported Lotus Notes Versions- Supports all versions of Lotus Notes including 1.0 to 8.5 

Supported MS Excel Versions- Supports all versions of MS Excel 97, 98, 2000, 2002 and 2003 

 Lotus Notes and Novell GroupWise client should be installed on the computer
system on which you are performing the conversion. You cannot convert 
mailboxes if both the above mentioned applications are not installed on the host 
computer. Also, you need to have MS Excel installed on your computer for 

creating Excel database for batch file migration. 

2.2 Downloading Kernel for Novell GroupWise to Lotus Notes 

After checking your computer with the prescribed system requirements for Kernel for Novell GroupWise 
to Lotus Notes, you can download and install the software on your computer. You can buy the full 
version of the software from any one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel for Novell GroupWise to Lotus Notes before buying it, you can download 
the evaluation version from the following link: 

http://www.nucleustechnologies.com/download-groupwisetonotes.html 

 Using the evaluation version of Kernel for Novell GroupWise to Lotus Notes, you
can convert all the data from GroupWise mailbox to Lotus Notes but can save only 

10 email items per folder. 

2.3 Install Kernel for Novell GroupWise to Lotus Notes 

After downloading the installer file for Kernel for Novell GroupWise to Lotus Notes, you can install the 
software by running the file. 

 Before installing the software make sure that the host computer meets the entire
system requirements and has sufficient memory available. 

To install Kernel for Novell GroupWise to Lotus Notes: 

1. Double-click the Kernel for Novell GroupWise to Lotus Notes installer.

2. Follow the on-screen instructions.

The Setup Installation Complete screen will be displayed. 

http://www.nucleustechnologies.com/download-groupwisetonotes.html
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3. Click Finish, the main window of the Kernel for Novell GroupWise to Lotus Notes software will be

launched. 

3.1 Start Kernel for Novell GroupWise to Lotus Notes 

To start Kernel for Novell GroupWise to Lotus Notes: 

Click the Start  All Programs  Kernel for Novell GroupWise to Lotus Notes  Kernel for Novell 
GroupWise to Lotus Notes 

Alternatively, you can launch Kernel for Novell GroupWise to Lotus Notes by double-clicking the shortcut 
icon available on the desktop and Quick Launch icon. 

3.2 Uninstall Kernel for Novell GroupWise to Lotus Notes 

You may need to uninstall and re-install Kernel for Novell GroupWise to Lotus Notes. 

To uninstall Kernel for Novell GroupWise to Lotus Notes: 

1. Click the Start  All Programs Kernel for Novell GroupWise to Lotus Notes  Uninstall
Kernel for Novell GroupWise to Lotus Notes

A warning message will be displayed. 

2. Click Yes to uninstall Kernel for Novell GroupWise to Lotus Notes.

 Before proceeding to uninstall Kernel for Novell GroupWise to Lotus Notes, you
must ensure that the software is not running. 

You can alternatively uninstall Kernel for Novell GroupWise to Lotus Notes from the Control Panel by 

performing the following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon.

2. Select Kernel for Novell GroupWise to Lotus Notes and click Remove.

A warning message will be displayed. 

3. Click Yes to uninstall Kernel for Novell GroupWise to Lotus Notes.
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4. Software Interface

Now that Kernel for Novell GroupWise to Lotus Notes has been installed on your computer, you can start 
using the software after getting acquainted with the software interface. 

4.1 Kernel for Novell GroupWise to Lotus Notes 

Kernel for Novell GroupWise to Lotus Notes software allows you to perform Novell GroupWise to Lotus 
Notes migration with the help of two migration options: Single Mailbox Migration and Batch file Migration. 
Have a close look at the software interface: 

4.1.1 Menu Bar 

The menu-bar of Kernel for Novell GroupWise to Lotus Notes comprises three main menus – File, Tool, 
and Help.  

4.1.1.1.  File Menu 

The File menu comprises four menu items. 

Figure 4.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Single Mailbox Select this option to convert Single GroupWise User mailbox 

Batch File Select this option to convert Multiple GroupWise user mailboxes 
saved in a batch file 

Export Select this option to export/save items of the mailbox 

Exit Select to close the software 
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4.1.1.2. Tool Menu 

The Tool menu comprises a single menu item. 

Figure 4.2: Tool Menu 

Menu Item in the Tool menu: 

Field Name Field Description 

Advanced Options Select this option to view advanced options to 
customize various activities. Enable or disable the 
appropriate checkbox field as per your requirement 

4.1.1.3. Help Menu 

The Help menu comprises three menu items. 

Figure 4.3: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Select to view help information pertaining to performing 
various tasks using Kernel for Novell GroupWise to 
Lotus Notes. 

Software Homepage… Select to visit software homepage on our website 

About Kernel for Novell 
GroupWise to Lotus Notes 

Select to view version-related and support information of 
Kernel for Novell GroupWise to Lotus Notes 
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4.1.2 Tool Bar 

The tool-bar in Kernel for Novell GroupWise to Lotus Notes is displayed below the menu-bar. Tool bar is 
displayed just below the menu-bar in the software interface. It offers a convenient method for performing 
varied functions that are otherwise performed by using the Menu Bar. Following are buttons available in 
the tool bar along with their respective use: 

Button Button Name Button Description 

Single Mailbox Click this button to convert Single GroupWise 
User mailbox 

Batch File Click this button to convert Multiple GroupWise 
user mailboxes saved in a batch file 

Export Click this button to export/save items of the 
mailbox 

Help Click this button to view Users Help manual of 
Kernel for Novell GroupWise to Lotus Notes 
software 

4.2 Kernel for Novell GroupWise to Lotus Notes Batch Migration 
File Creator 

As the batch file creation tool - Kernel for Novell GroupWise to Lotus Notes Batch Migration File Creator 
has been installed automatically on your computer system along with the installation of Kernel for Novell 
GroupWise to Lotus Notes software; you can start creating batch file to perform multiple mailboxes 
migration after getting acquainted with the software interface of batch migration file creator tool. 

4.2.1 Menu Bar 

Mentioned below are the menu bar items used in Kernel for Novell GroupWise to Lotus Notes Batch 
Migration File Creator software: 

4.2.1.1. Help Menu 

The File menu has six menu items: New File, Add Record, Open, Save, Save As and Exit to help users 
in performing functions described below: 
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Figure 4.4: File menu of Batch Migration File Creator 

Field Name Field Description 

New File Select this option to remove the existing CONLN files 
enlisted in the Kernel for Novell GroupWise to Lotus 
Notes Batch Migration File Creator software and create 
new record for a new batch file 

Add Record Select this option to add new record of the user mailbox 
in a batch file 

Open Select this option to open an existing .CONLN batch file 

Save Select this option to save the .CONLN batch file 

Save As Select this option to select the location on your hard 
drive to save the .CONLN batch file 

Exit Select this option to exit from the software 

4.2.1.2. Edit Menu 

Edit Menu has Remove option to help user perform following function: 

Figure 4.5: Edit menu for Batch Migration File Creator 
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4.2.1.3. View Menu 

View Menu has two menu items including Toolbars and Status Bar to help the users perform following 
functions: 

Figure 4.6: View menu for Batch Migration File Creator 

Field Name Field Description 

Toolbars Select this option to view or hide toolbar of Kernel for 
Novell GroupWise to Lotus Notes Batch Migration File 
Creator software 

Status Bar Select this option to view or hide status Bar of Kernel for 
Novell GroupWise to Lotus Notes Batch Migration File 
Creator software 

4.2.1.4. Help Menu 

The Help Menu has three menu items: Help, Software Home Page and About Kernel for Novell 
GroupWise to Lotus Notes Migration File Creator: 

Figure 4.7: Help menu for Batch Migration File Creator 

Field Name Field Description 

Remove Select this option to remove the selected record from the 
list 
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Field Name Field Description 

Help Select to view help information pertaining to performing 
various tasks using Kernel for Novell GroupWise to 
Lotus Notes Batch Migration File Creator 

Software Homepage… Select to visit software homepage on our website 

About Kernel for Novell 
GroupWise to Lotus Notes 
Migration File Creator 

Select to view version-related and support information of 
Kernel for Novell GroupWise to Lotus Notes Batch 
Migration File Creator 

4.2.2 Tool Bar 

Tool bar is displayed just below the menu-bar in the software interface. It offers a convenient method for 
performing varied functions that are otherwise performed by using the Menu Bar. Following are buttons 
available in the tool bar along with their respective use: 

Button Button Name Button Description 

New Click this button to remove all existing records 
listed in the Kernel for Novell GroupWise to 
Lotus Notes Batch Migration File Creator 
software and create new record for a new 
batch file 

Open Allows you to open the existing .CONLN file 

Save Allows you to save the .CONLN batch file 

Save As Allows you to define the location on your hard 
drive to save the .CONLN file 
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Add Record Allows you to add the records/details of the 
GroupWise user mailbox 

Remove Enables you to remove the selected record 
from the list 

Help Enables you to view User's Help Manual of 
Kernel for Novell GroupWise to Lotus Notes 
Batch Migration File Creator software 

Import Excel Allows you to import excel worksheet with 
added information about the batch of 
GroupWise mailbox(s) to be migrated 
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5. Migrating from Novell GroupWise to Lotus

Notes

Now that you have complete familiarity of the user interface of Kernel for Novell GroupWise to Lotus 
Notes, you are ready to perform the migration of GroupWise mailbox(s). 

5.1 Single Mailbox Migration 

1. Launch Kernel for Novell GroupWise to Lotus Notes software:

Figure 5.1: Main Window of Kernel for Novell GroupWise to Lotus Notes 

2. Select this option to convert single GroupWise Mailbox option and click Next button to convert
Single GroupWise mailbox.

The following window will be displayed:
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Figure 5.2: Window showing three modes 

This window displays the following three modes to connect to the mailboxes of Novell GroupWise: 

Default Mode- Allows you to convert the items of current/default mailbox in GroupWise client. 

Login Mode- Further provides sub-modes where mailboxes are connected and migrated. The 

sub-modes allow you to fetch mailbox with the details such as Online (IP address & Port details), 
Caching Mailbox Path and Remote Mailbox path.  

Command Line Mode (for advance migration) - Enables you to access and convert 

GroupWise mailbox without accessing or opening the GroupWise client. All you have to do is 
type complete mailbox path.  

 Migrate Archive Items 

Enable this option to migrate archived items with the other items: 

Use default Archive path- Select this option if you want the software to fetch archives from the 

default archive folder path  
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Specify Archive path- Select this option to specify any other path to locate archive folder 

5.1.1 Default Mode 

Select Default mode to migrate the current working user mailbox in Novell GroupWise client. 

In order to select Default Mode, first select “Select this option to convert Single GroupWise Mailbox" 
option on Software Home Page and click Next. The following window will appear: 

Figure 5.3: Using Default Mode 

 The “Use Default” option is selected by default in the software

1. Select the Use Default option to fetch data from GroupWise mailbox in Default mode. This option is

selected by-default in the software and therefore connects to the currently opened GroupWise
mailbox in Novell GroupWise Client.

 Select the Migrate Archive items option to migrate archived emails
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2. Click the Next button. Kernel for Novell GroupWise to Lotus Notes will scan the GroupWise mailbox

meticulously for the existing items in it and display all of them in a tree-like structure:

Figure 5.4: Enlisted Folders from Novell GroupWise mailbox 

3. Click on any of the folder to preview the contents of the folder. You can select any of the tab to
preview the contents in text or HTML format:
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Figure 5.5: Preview Window 

4. Click the Export button to continue. Software will display the following dialog:
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Figure 5.6: Export Options for saving converted data 

Select the item types- Select the items from Mail messages, Calendar entries, Tasks and 
Contacts that you want to migrate from GroupWise mailbox to NSF file format.  

Select Creation date- Select the time period for which time duration you want to perform the 
migration. You can select from options of Select predefined time period or Specify Time period 
manually  

Select NSF file destination- Click the  button to select the NSF Folder Path where you wish 
to save the converted NSF file. Similarly, type NSF File Name that you want to name the newly 
created NSF file.  

Save item content in text format- Select this option to save the migrated data in text format and 
accelerate the saving process.  
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5. After you select the required options for exporting the converted data, the software starts saving the
migrated data:

Figure 5.7: Saving Process 

6. After the software performs the Novell GroupWise to Lotus Notes migration flawlessly, it shows the
screen given:
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Figure 5.8: Saving Complete 

7. The software also provides its users with Log file in .txt format so that you can check the events that
took place while migrating the Novell GroupWise mailbox to NSF file format.

5.1.2 Login Mode 

Login Mode further offers three sub-modes: Online, Caching and Remote Login mode: 

Online Mode 

Online mode allows you to get connected to the GroupWise mailbox but requires the user authentication 
for user mailbox, IP Address and Port of the computer system where user mailbox exists or is saved. In 
order to fetch GroupWise mailbox data through Online mode, follow the steps given below: 

1. Select the Online option to access the GroupWise mailbox in Online mode. When you select this
option, User ID, Password, Address and Port text field(s) activate, so that you can enter the details of
the required GroupWise mailbox:
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Figure 5.9: Using Online Mode 

2. Type the User ID and Password of the GroupWise Mailbox that you want to migrate from Novell

GroupWise to Lotus Notes. Also, type the IP address and Port number of the computer where Novell

GroupWise server is installed:
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Figure 5.10: Entering Authentication details for Online Mode 

3. Click the Next button to continue. Kernel for Novell GroupWise to Lotus Notes will connect to the

allied GroupWise mailbox with the provided details, scan the file to extract items and then software

will enlist these items in tree-like structure:
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Figure 5.11: Preview Window 

Select any of the folders to check the preview of the contents including Emails, Calendar, Contacts 
and other items. Right pane of the window displays the respective items of the folder selected from 
the left pane.  

The bottom pane of the window contains two tabs: Text and HTML. You can select any of the tabs to 
view the preview of selected email in Text or HTML format. 

4. Click Export button to continue and save the converted data as mentioned in Step 4 in Section 5.1.1

5. After you select the required options for exporting the converted data, the software starts saving the
migrated data.

6. After the software performs the Novell GroupWise to Lotus Notes migration flawlessly. The software
also provides its users with Log file in .txt format so that you can check the events that took place
while migrating the Novell GroupWise mailbox to NSF file format.

 Select the Migrate Archive items option to migrate archived emails



© KernelApps Private Limited

Caching Mailbox Path Mode 

This mode helps the user to get connected to the Caching mailbox of GroupWise mailbox and requires 
User ID and Password as the authentication to access Caching Mailbox. 

 Prior to using this mode, ascertain that your administrator has enabled the Cache
mode in Novell GroupWise Server 

In order to fetch GroupWise mailbox data through Caching Mailbox Path, follow the steps given below: 

1. Select the Caching mailbox path option to access the GroupWise mailbox in Online mode. When

you select this option, User ID, Password and Caching mailbox path field(s) activate, so that you can
enter the details of the required GroupWise mailbox:

Figure 5.12: Using Caching Mailbox path 
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2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to

Lotus Notes. Also define the caching mailbox path with the  button

3. Click the Next button to continue. Kernel for Novell GroupWise to Lotus Notes will connect to the

allied GroupWise mailbox with the provided details, scan the file to extract items and then software
will enlist these items in tree-like structure.

4. Select any of the folders to check the preview of the contents including Emails, Calendar, Contacts
and other items. Right-pane of the window displays the respective items of the folder selected from
the left pane.

The bottom pane of the window contains two tabs: Text and HTML. You can select any of the tabs to
view the preview of selected email in Text or HTML format.

5. Click Export button to save the converted data and save the converted data as mentioned in Step 4

in Section 5.1.1

6. After you select the required options for exporting the converted data, the software starts saving the
migrated data.

7. Software performs the Novell GroupWise to Lotus Notes migration flawlessly. The software also
provides its users with Log file in .txt format so that you can check the events that took place while
migrating the Novell GroupWise mailbox to NSF file format.

 Select the Migrate Archive items option to migrate archived emails

Remote Mailbox Path Mode 

Remote Mailbox Path mode allows you to get connected to GroupWise mailbox with remote path of the 
location where the mailbox is saved. To fetch the data from the user mailbox, you need to provide the 
path and password of the user mailbox. In order to fetch GroupWise Mailbox with Remote Mode, follow 
the process given below:  

1. Select the Remote mailbox path option to access the GroupWise mailbox in remote mode. This
option activates password field to enter the password of the GroupWise mailbox:
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Figure 5.13: Using Remote Mailbox path 

 You need to enter password for password-protected mailboxes. If the mailbox is
not password protected, then you do not require entering password 

2. Type the password of the mailbox which you want to migrate using Kernel for Novell GroupWise to

Lotus Notes. Also define the remote mailbox path through the  button.

3. Click the Next button to continue. Kernel for Novell GroupWise to Lotus Notes will connect to the
allied GroupWise mailbox with the provided details, scan the file to extract items and then software
will enlist these items in tree-like structure.

4. Select any of the folders to check the preview of the contents including Emails, Calendar, Contacts
and other items. Right pane of the window displays the respective items of the folder selected from
the left pane.

The bottom pane of the window contains two tabs: Text and HTML. You can select any of the tab to
view the preview of selected email in Text or HTML format.
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5. Click Export button to save the converted data and save the converted data as mentioned in Step 4

in Section 5.1.1

6. After you select the required options for exporting the converted data, the software starts saving the
migrated data.

7. Software performs the Novell GroupWise to Lotus Notes migration flawlessly. The software also
provides its users with Log file in .txt format so that you can check the events that took place while
migrating the Novell GroupWise mailbox to NSF file format.

 Select the Migrate Archive items option to migrate archived emails

5.1.3 Command Line Mode 

Using Command Line Mode of Kernel for Novell GroupWise to Lotus Notes allows you to access the 
Novell GroupWise mailbox without opening or accessing the GroupWise.exe and user mailbox account. 
If you know the path where GroupWise mailbox is saved, then you can fetch the mailbox data by typing 
the path in Command Line mode and gain access to mailbox data easily.  

1. Select Command Line option to perform the migration with Command Line Mode:
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Figure 5.14: Using Command Line Mode 

Software prompts you to enter User ID, Password and Path of the Novell GroupWise user 
mailbox to perform migration process 

2. Type the User ID, password and user mailbox path of Novell GroupWise Client can be accessed
remotely with the switch and the complete path of the GroupWise user mailbox which is required
to be converted.

 Remote Novell GroupWise mailbox can be accessed with the switch and the
complete path of the mailbox which is required to be migrated. 

3. Click the Next button to continue. Kernel for Novell GroupWise to Lotus Notes scans the mailbox

and enlists all the folders in a tree like structure. You can preview the contents by selecting the
folders from the left pane. Also you can view the preview in two tabs: Text and HTML

4. Click the Export button to save the converted data and save the converted data as mentioned in

Step 4 in Section 5.1.1

5. After you select the required options for exporting the converted data, the software starts saving
the migrated data.



© KernelApps Private Limited

6. Software performs the Novell GroupWise to Lotus Notes migration flawlessly. The software also
provides its users with Log file in .txt format so that you can check the events that took place
while migrating the Novell GroupWise mailbox to NSF file format.

 Select the Migrate Archive items option to migrate archived emails

5.2 Multiple Mailbox Migration 

You can convert multiple GroupWise Mailboxes using Kernel for Novell GroupWise to Lotus Notes. In 
order to convert multiple GroupWise mailboxes you need to create a CONLN file. You can create the 
CONLN file using Kernel for Novell GroupWise to Lotus Notes Batch Migration File Creator. You can 
convert multiple GroupWise Mailboxes in the following two ways: 

5.2.1 Creating .CONLN file 

Batch file is a file using which you can enlist and save GroupWise user mailbox information to convert 
multiple GroupWise user mailboxes at once. Create Batch file and save records of unlimited GroupWise 
user mailbox accounts. Creation of batch file eases the task of defining the saving location for the 
converted mailboxes in NSF file format.  

1. Launch Kernel for Novell GroupWise to Lotus Notes Batch Migration File Creator software by clicking
Start > All Programs > Kernel for Novell GroupWise to Lotus Notes > Kernel for Novell
GroupWise to Lotus Notes Batch Migration File Creator. Welcome Page of the software appears:
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Figure 5.15: Welcome Screen of Batch file creator tool 

2. Select Add Record option from the File menu or click the Add Record button from the tool bar. The
GroupWise Information window gets displayed:
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Figure 5.16: GroupWise Information Dialog 

You need to enter the following details for creating a CONLN batch file: 

GroupWise Login Details  

Field Name Field Description 

User ID Type the user ID of the GroupWise user mailbox that 
you want to migrate 

Password Type the password of the GroupWise Mailbox that you 
want to migrate 

Online Connect to the GroupWise mailbox using the Online 
mode. To do so, you need to enter details including IP 
Address and Port Number 
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Caching Mailbox Path Connect to GroupWise mailbox by selecting the Caching 

mailbox path using the  button 

Remote Mailbox Path Connect to GroupWise mailbox by selecting the Remote 

mailbox path using the  button 

Command Line (for 
advance migration) 

Define command line to access GroupWise mailbox 

Advance Options Details 

Field Name Field Description 

User Name 
Type the user name of the computer where remote 
mailbox is stored  

Password 
Type the password of the computer where remote 
mailbox is stored  

Computer Name/IP 
Type the Computer Name/IP of the computer where 
remote mailbox is stored  

Archive Details 

Field Name Field Description 

Migrate Archive Items 
Select this checkbox to define details of the archive 
folder for a user mailbox so that you can migrate archive 
items too  

Use default Archive path 
Select this option if you want the software to fetch the 
archive items from the default Archive location path  

Specify Path Select this option to define the path of Archive folder 

3. After selecting the required options and filling the required details, click the Next button, the following
dialog appears:
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Figure 5.17: Defining NSF file location for saving the converted data 

Here you need to enter the NSF File Path or desired location where you wish to save the converted 
data. Type NSF File Name that you want to give to the NSF file.  

4. Click Finish button to continue saving the CONLN file. All the created records of the GroupWise User

Mailboxes gets listed in the software
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Figure 5.18: Enlisted Mailbox records 

 You can edit details of the selected GroupWise User Mailbox from left pane of the
window i.e. from the Record Details section 

5. Click the Save button from the tool bar to save the batch file or click the Save As button to select and

save disk saving location of the file on your computer system
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Figure 5.19: Saving the .CONLN file 

Kernel for Novell GroupWise to Lotus Notes Batch Migration File Creator software by default creates 
*.conln file which is the batch file for multiple GroupWise mailbox conversion. 

5.2.2 Creating Excel database file 

You can also prepare an Excel database file that comprises of complete information about the Novell 
GroupWise user mailboxes. Being a network administrator, you can save a lot of time which gets utilized 
in creating .CONLN batch file and editing it. With this feature in the software, you can save details in 
.XLS file and export it to Kernel for Novell GroupWise to Lotus Notes Batch Migration File Creator 
software and then save it to .CONLN Batch file for multiple mailbox conversion.   

The Excel worksheet that you import should be in the following format: 

Firstly, the spreadsheet must be named NucleusExcelSheet  

Sheet should consist of 15 columns:     

1. Mode

2. User ID

3. Password

4. Address

5. Port

6. Caching Mailbox Path

7. Remote Mailbox Path

8. Command Line
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9. User Name

10. User Password

11. Computer Name/IP

12. NSF File Path

13. NSF File Name

14. Save Archive

15. Archive Path

Figure 5.20: Excel sheet format 

Filling up the Excel file for different Login modes 

The different fields are to be filled according to one of the login types selected. The four login types are: 
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1. Online

2. Caching Mailbox Path

3. Remote Mailbox Path

4. Command Line (for advanced migration)

First field of the excel sheet can take any one of the above-mentioned values only. The rules to fill 
different fields according to login type are as follows:  

Login Mode (Online) 

Mentioned below fields are mandatory while using this mode: 

User ID: Type the user name of the mailbox 

Password: Type the password of the mailbox 

Address: Type the IP address of the Novell GroupWise Server  

Port: Type the Port Number of the Novell GroupWise Server 

Archive Details: Type “NO” in this field if you want to migrate mailbox items only 

Save in NSF file: There are two fields in this option- NSF File Path and NSF File Name 

Caching Mailbox Path 

Mentioned below fields are mandatory while using this mode: 

User ID: Type the user name of the mailbox 

Password: Type the password of the mailbox 

Caching Mailbox Path: List the path for Caching Mailbox of Novell GroupWise mailbox that you want to 
migrate 

Archive Details: Type “NO” in this field if you want to migrate mailbox items only 

Advance Options: There are three fields to be filled in advance options- User name of network computer, 
its password and Computer Name/IP of the network computer where mailbox is saved 

 Although, advance option fields are not compulsory, but recommended. If these

fields are not filled, it will be shown as a warning. 
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Save in NSF file: There are two fields in this option- NSF File Path and NSF File Name 

Remote Mailbox Path 

Mentioned below fields are mandatory while using this mode: 

Password: Type the password of the mailbox 

Remote Mailbox Path: List the path for Remote Mailbox of Novell GroupWise mailbox that you want to 
migrate 

Archive Details: Type “NO” in this field if you want to migrate mailbox items only 

Advance Options: There are three fields to be filled in advance options- User name of network computer, 
its password and Computer Name/IP of the network computer where mailbox is saved 

 Although, advance option fields are not compulsory, but recommended. If these

fields are not filled, it will be shown as a warning. 

Save in NSF file: There are two fields in this option- NSF File Path and NSF File Name 

Command Line Mode 

Mentioned below fields are mandatory while using this mode: 

User ID: Type the user name of the mailbox 

Password: Type the password of the mailbox 

Command Line: This field is necessary, if not filled the software will show certain error messages 

Archive Details: Type “NO” in this field if you want to migrate mailbox items only  

Save in NSF file: There are two fields in this option- NSF File Path and NSF File Name  

5.2.3 Migrate Archived Items 

If the archived items for mailbox(s) are required for migration and you require working with Excel 
database, then you need to perform the following steps for this process: 

1. Open the Excel database. Consider that you are using Remote Mailbox mode and need to
migrate the archived items for mailbox(s).
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2. Fill the required details including Password, Remote Mailbox Path, NSF file location, NSF file
Name and type YES or Path of the archive folder of user mailbox:

Figure 5.21: Excel file with details 

 When you select performing archive migration, software will enlist only the
archived file items for preview and saving. Other mailbox items are not displayed 

when you select migrating archived items. 

3. Import Excel database to Kernel for Novell GroupWise to Lotus Notes Batch Migration File
Creator that will display compiled output window with errors, warnings and number of scanned
records from the Excel database

4. Click Save As option to save the records in CONLN batch file at the appropriate location

5. Now Launch Kernel for Novell GroupWise to Lotus Notes software and select the batch file
conversion option to enlist the CONLN file and perform migration
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5.2.4 Importing Excel database file 

After you have created the Excel Database file, you must save the database with .CONLN file extension 
so that you can use this file for multiple GroupWise mailbox migration.  

1. Launch Kernel for Novell GroupWise to Lotus Notes Batch Migration File Creator software. The Home
page appears:

Figure 5.22: Batch file creator software 

2. Click the Import Excel button on the Tool bar. Software displays the Open window to select
NucleusMigrationFile (.XLS) from the location. Browse for the file and enlist the same:
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Figure 5.23: Fetching Excel File 

 At times, certain errors might appear which are displayed in compilation output
dialog. Modify as per the compilation output provided by the software. If there are 
no errors then click OK to proceed. 

The saved mailbox details will get listed in the software: 
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Figure: 5.24: Listing of Mailboxes 

3. Click the Save As button from the toolbar to save the listed items as .CONLN batch file at appropriate
location. Now launch Kernel for Novell GroupWise to Lotus Notes Migration to select the option to
convert batch of GroupWise Mailboxes and list the .CONLN batch file for migration.

5.2.5 Using CONLN Batch file for Migration 

Batch file is used in Kernel for Novell GroupWise to Lotus Notes software to perform multiple GroupWise 

mailboxes migration. Here is the process of how you can import the .CONLN batch for multiple 

GroupWise mailbox migration: 

1. Launch Kernel for Novell GroupWise to Lotus Notes migration software. The main window appears:
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Figure 5.25: Main Window 

2. Select the Select this option to convert batch of GroupWise Mailboxes option and click the Next
button. The „Open‟ dialog gets displayed:
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Figure 5.26: Opening CONLN file 

3. Select the CONLN batch file and click the Open button. The software displays the enlisted
GroupWise mailbox details in the following way:
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Figure 5.27: CONLN file listed 

4. Click the Export button to perform migration of multiple GroupWise mailboxes to NSF file format.
After this, Kernel for Novell GroupWise to Lotus Notes software initiates the saving process of Novell
GroupWise user mailboxes and saves the converted mailbox items at a user-defined save location.

 To get a fair idea of working of converting batch of GroupWise Mailboxes, refer to
Convert Multiple GroupWise Mailboxes section of Kernel for Novell GroupWise to 
Lotus Notes Help manual 
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6. Advanced Options to ease Migration

New Advance Options added in Kernel for Novell GroupWise to Lotus Notes software are provided to 
ease the task of email migration from Novell GroupWise mailboxes to NSF files.  

To view and implement advance options select Advance Options from Tool menu: 

Figure 5.28: Advance Options dialog 

Prompt for folder selection for each mailbox, while using batch file mode- Selecting this option, you can 
select required folders for saving after you performed migration with Kernel batch file of unlimited 
mailboxes in one go. This option allows you to activate or deactivate this prompt before you start 
performing batch file migration: 
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Figure 5.29: Folder Selection dialog 

The Folder Selection dialog appears during the batch of mailboxes migration process, when a user 
selects Prompt for folder selection for each mailbox, while using batch file mode option.  

Show all address books- Select this option to view all the address book(s) of GroupWise mailbox 

during mailbox preview prior to saving the items.  

Advance settings for Sent Items- Select this option to activate advance settings for Sent Items. In 
case, Sent Items folder emails are listed and converted slowly, then selecting this option will make the 
process faster.  

Change name of GroupWise folders while migrating Lotus Notes: This option will allow you to 
change the folder names of GroupWise mailbox while migrating to Lotus Notes. Selecting this option will 
allow you to activate the section where Add Folder, Remove Folder, Use Default and Apply buttons are 
listed. Now you can easily alter the folder names of GroupWise mailbox and Lotus Notes file for Novell 
GroupWise to Lotus Notes migration. To add a folder, click on Add Folder button and it will display the 
following dialog: 
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Figure 5.30: Add Folder dialog 

Simply type Folder Description, GroupWise Folder (GW Folder) and NSF Folder Name to Add a Folder 
in the existing list. Similarly, you can remove a Folder by selecting the row or Use Default folder names. 

Select the item types to migrate- Select from the items available for Novell GroupWise to Lotus Notes 

migration. The list of items includes email messages, calendar entries, tasks and contacts. 

7. Full Version

Although you can use Kernel for Novell GroupWise to Lotus Notes evaluation version for free and 
experience the capabilities of the software, there are certain features that are not available in the 
evaluation version. 

7.1 Requirement of Full Version 

Kernel for Novell GroupWise to Lotus Notes is available for free trial download. The evaluation version is 
fully functional and provides the user with a fair idea about the capability and accuracy of the software. 
The free evaluation version of Kernel for Novell GroupWise to Lotus Notes has certain restrictions. The 
free version allows you to save only 10 email items per folder.  

In order to perform comprehensive Novell GroupWise to Lotus Notes migration and save the entire email 
items so recovered, you must purchase the Full version of Kernel for Novell GroupWise to Lotus Notes 
software, which is available at an affordable price. 

7.2 Purchasing Full Version 

You can buy the full version of Kernel for Novell GroupWise to Lotus Notes online. As soon the purchase 
transaction gets completed, our sales team will send you an email comprising the URL to download the 
full version of Kernel for Novell GroupWise to Lotus Notes and activation details of the software. 
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8. Support

We have an extensive and efficient support system in place to assist our customers with all issues 
related to using Kernel for Novell GroupWise to Lotus Notes. The software comes with an embedded 
help manual that can be accessed by clicking HelpSoftware Help in the menu-bar. You can also 
press the F1 key on the keyboard of your computer to access the embedded help of Kernel for Novell 
GroupWise to Lotus Notes. 

You can access the online help for Kernel for Novell GroupWise to Lotus Notes at 

http://www.nucleustechnologies.com/Online-Helps.html 

We also have live support wherein you can chat with our software experts at 

http://www.nucleustechnologies.com/Support.html  

To talk on phone with our software experts call: 

Help line:  

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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9. Legal Notices

This section comprises the legal specification about Kernel for Novell GroupWise to Lotus Notes and the 
company LEPIDE SOFTWARE PRIVATE LIMITED 

9.1 Copyright 

LEPIDE SOFTWARE PRIVATE LIMITED, Kernel accompanied user manual and documentation are 
copyright of LEPIDE SOFTWARE PRIVATE LIMITED, with all rights reserved. Under the copyright laws, 
this user manual cannot be reproduced in any form without the prior written permission of LEPIDE 
SOFTWARE PRIVATE LIMITED. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

© LEPIDE SOFTWARE PRIVATE LIMITED. All rights reserved. 

9.2 Trademark 

Kernel ® is a copyright work of LEPIDE SOFTWARE PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS are registered 
trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective 
companies. 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is 
subject to change without notice. LEPIDE SOFTWARE PRIVATE LIMITED provides no warranty with 
regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing LEPIDE SOFTWARE PRIVATE LIMITED assumes no liability for any damages incurred 
directly or indirectly from any technical or typographical errors or omissions contained herein or for 
discrepancies between the product and the manual. In no event shall LEPIDE SOFTWARE PRIVATE 
LIMITED, be liable for any incidental, consequential special, or exemplary damages, whether based on 
tort, contract or otherwise, arising out of or in connection with this manual or any other information 
contained herein or the use there of. 

9.4 License Agreement 

Kernel for Novell GroupWise to Lotus Notes Copyright © by KernelApps Private Limited. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by KernelApps Private Limited. 
The terms and conditions of this License describe the permitted use and users of each 
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Licensed Copy of Kernel for Novell GroupWise to Lotus Notes. For purposes of this License, if you have 
a valid license, you have the right to use a single Licensed Copy of Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Novell GroupWise to Lotus Notes may either be used by a single 
person or used non-simultaneously by multiple people who use the software personally installed on a 
single workstation. All rights of any kind in Kernel, which are not expressly granted in this License, are 
entirely and exclusively reserved to and by KernelApps Private Limited. You may not rent, lease, 
modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Kernel, nor permit anyone else to do so. You may not make access to Kernel available to others in 
connection with a service bureau, application service provider, or similar business, nor permit anyone 
else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Novell GroupWise to Lotus Notes, and any and all accompanying software, files, data and 
materials, are distributed and provided AS IS and with no warranties of any kind, whether expressed or 
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good 
data processing procedure dictates that any program, including Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of 
the copies of Kernel covered by this License. This disclaimer of warranty constitutes an essential part of 
this License. In addition, in no event does KernelApps Private Limited authorize you or anyone else to 
use Kernel for Novell GroupWise to Lotus Notes in applications or systems where Kernel for Novell 
GroupWise to Lotus Notes failure to perform can reasonably be expected to result in a significant 
physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold 
KernelApps Private Limited harmless from any and all claims or losses relating to such unauthorized 
use.  

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction 
and venue for all matters relating to this License shall be in courts and for a located in the State of 
Delhi, and you consent to such jurisdiction and venue. There are no third party beneficiaries of any 
promises, obligations or representations made by KernelApps Private Limited herein. 

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute, nor 
contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same 
provision, or any other provision, of this License.  


